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About This Guide

This Getting Started Guide is intended as an overview of installation and
basic usage for HP StorageWorks Library and Tape Tools (L&TT). For
detailed information on any procedure, refer to the user guide or online
help.

The Microsoft Windows version of L&TT uses a graphical user interface
([EL0)), whereas the NetWare, HP-UX, Tru64, and Linux versions of the
program use a command screen interface ([CSI]). Click the appropriate
bookmark in the left panel to display the section of this guide that
corresponds to your operating environment.

Supported Products and Operating Systems

For a complete listing of compatible products, refer to the HP Library
and Tape Tools Compatibility Matrix found at:

http:/ / www.hp.com/ support/Itcompatibility

Finding Additional Information

The HP website provides the current version of L&TT for download, and
general information about the tool. Access the website at:

http://www.hp.com/support/tapetools

You can quickly access this website by clicking the L&TT Support link
in the navigation bar from any page in this Getting Started Guide.

Getting Support

E-mail support is available from |tf_team@hp.com. You should expect a
response within 24 hours (usually sooner) during a normal business
week.

Use this address to obtain support for L&TT, to report bugs, to provide
feedback on this manual, to report any issues with the L& TT website, or
to provide enhancement suggestions. HP appreciates feedback on how to
make improvements for future versions of L&TT.

Note: This address is intended to provide support for L&TT software. This
address is NOT for assistance in troubleshooting hardware products. Refer to
the é:locumentction that comes with your hardware for support options for that
product.

Installing L&TT for Windows

The Windows version of L&TT uses the InstallShield application.
InstallShield lets you choose the installation directory and select other
options. It also sets up shortcuts to launch the application in the Start
menu and on the desktop. The Start menu shortcuts also provide access
to the online help, the readme file, the report viewer, and the uninstaller.

Installation Procedure

To install the Windows version of L&TT:

1. Download or copy the self-extracting executable file to a temporary
location.

2. Double-click the self-extracting executable file to launch the
installer. The InstallShield Wizard screen is displayed.

3. Click Next. Read the program license agreement and click Yes if
you agree to and accept the terms of the license agreement.

4. Read the readme file for any last-minute changes to the
documentation, then click Next. The Select Components screen is
displayed.

5. Select the desired components to install and click Next.

In most cases, the default settings of this screen are adequate.
Windows NT 4.0, Windows 2000, and Windows XP users have the
option to install Advanced SCSI Programming Interface (ASPI)
support. With Windows 9x installations, the ASPI component is
required and automatically included in the L&TT installation
process. HP recommends that you not install ASPI support unless
you have a good reason to do so. ASPI support is beneficial when
installed storage applications cannot be shut down, and those

applications have locked access to the device through the Miniport
driver. If ASPI is installed, it is generally not necessary to shut
down these applications to access devices through L&TT (although
the applications should not be accessing the devices while L&TT is
running). ASPI lets you run L&TT on a locked device without
rebooting; however, a reboot is required after installing ASPI.

6. Select a destination location to install the program. You can accept
the default location or click Browse to install to a different location.
After choosing the destination location, click Next.

7. Indicate the program directory in which you want the setup
program to create program icons and click Next. The program
directory is created in the Programs directory of the Start menu.

8. On the Ready to start installation process screen, click Next. If
you need to review or change installation settings, click Back.

9. When installation is complete, click Finish to close the
InstallShield wizard.

Note: Under some circumstances, the installation process requires a reboot of
the system. For more information, refer to the user guide or the online help.

Starting L&TT

To start L&TT:
B Double-click the L&TT icon on the desktop (if present)
- Or -

B Click Start > Programs > HP StorageWorks Library and Tape
Tools > HP StorageWorks Library and Tape Tools

Using the Splash Screen

When L&TT is started, the splash screen opens. The splash screen gives
you the opportunity to exit the application before any SCSI bus activity
has taken place. This feature lets you exit the application if it was started
unintentionally. This prevents the program from interfering with any
backup or other storage applications that may currently be running.

The splash screen also allows you to select the SCSI I/O mode (if more
than one option is available). If you are installing a hardware device, the
Installation Check feature displays an HTML help screen that provides
instruction on common setup and device verification steps.

1/0 Mode

L&TT selects the input/output (I/O) mode that is most appropriate for
the system it is running on. However, this initial screen allows for
manual selection of the I/O mode in certain cases. L&TT currently
operates in the following two I/O modes:

B NT Miniport—uses an interface that is native to Windows NT 4.0,
2000, XP, and .NET. This is the preferred I/O mode on systems
where it is available because it does not require the installation of
the ASPI interface. However, there are some limitations to
theWindows NT Miniport I/O mode related to using devices that
are “claimed” by other applications, or that are used with non-
standard OS drivers. In those cases, selecting the ASPI I/O mode
can make a device accessible.

Note: The Windows NT Miniport |/O mode is not available on
Windows 9x.

B ASPI—uses an optional I/O programming interface that is available
on all versions of Windows. This I/O mode can be used with any
Windows operating system. It may require the installation or update
of additional OS components, possibly requiring a reboot of the
system during installation.

For information about other functionality of the splash screen, refer to
the user guide or online help.

Application Window Layout

After the I/O mode is selected, click Continue on the splash screen. The
L&TT main screen is displayed. Figure 1 shows the L&TT main screen
divided into three sections.
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Figure 1: L&TT main screen

The three sections of the L&TT main screen are:

1. Taskbar—This section contains buttons that provide quick access
to the main functions of L&TT and to the online help system.

Note: Above the Taskbar is the standard Windows menu bar that
provides alternate navigation to tool functions, as well as access o a
number of other features.

2. Device List—This is a multi-function window that offers several
options on the following tabs:

B Scan—This option provides either a summary status or
detailed information (depending on whether Show Details or
Hide Details is selected) about the bus scanning process. If a
problem is encountered during the scan, this information may
help in determining the cause. When the scan completes
successfully, the device list automatically switches to the By
Product tab.

The Scan tab also lets you rescan the bus. If any devices have
been hot-swapped or powered on after the OS has booted, in
most cases, the rescan feature can discover those devices
without requiring a reboot of the system.

Caution: Swapping SCSI devices, including connecting and
<:|isconnectin?1 cables and/or terminators, can cause the system to
hang or crash.

>

Caution: On Windows NT 4.0, 2000, XP, and .NET, changing
devices at a specific SCSI address can cause unpredictable
behavior. Parts of the operating system may not defect that the
device or device type has changed.

>

B By Product—This option shows a list of all the products
connected to the system. The list is grouped into the following
four categories:

— Libraries and autoloaders
— Drives

— Enclosures and processors
—  Other devices

The three number fields listed after the device represent the
device address. Each field in the address is separated by a
period: the first field represents the HBA channel, the second
field represents the SCSI ID, and the third field represents the
LUN.

Note: When using the Miniport |/O mode, the HBA channel field is
shown as “A/B,” where A is the channel and B is the subchannel.

B By Connection—This option shows all products connected to
the system, grouped by the HBA they are connected to. This
view makes it easy to see which devices are connected to the
same bus as the device in question, and may help in
understanding system 1I/O performance issues.
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B Instructions—This window contains brief instructions on
how to use the selected screen. This view can be disabled in
the software preferences.

3. Device Information screen—All the main functions of the
program are displayed in this window. The content of this window
depends on the device and tool function selected.

Using the Device Information Screen

When you select a product from the device list, the Device Information
screen displays information relevant to the device. The device list also
changes to display instructions on this page (if the instructions
preference is enabled). If another tool function is currently active, then
clicking the Identity button on the toolbar opens the Device
Information screen. The Device Information screen provides an
overview of the selected hardware device and its current configuration
and status.

‘When a standalone device is selected in the Device List, the Device
Information screen contains a single tab labeled Drive Information.
When a library or autoloader is selected in the device list, the Device
Information screen displays two tabs: one for library information and
one for the drives contained within the library.

To see information for the drives within the library, select the Drive
Information tab. This tab displays a screen very similar to the one for
standalone products, with the addition of the Selected Drive dropdown
menu.

Because a library can contain multiple drives, you can select and view
information for each drive using the Selected Drive dropdown menu. All
of the drives in the library are available in the dropdown menu.

Note: Selecting individual drives within a library from the By Product/By
Connection device list displays the drive as though it were a standalone
product. The recommended method of diagnosing embedded drives is fo first
select the library they belong to, and then select the specific drive within each
tool window.

Support Ticket Generation

A major feature of HP StorageWorks Library and Tape Tools is the
ability to generate a support ticket. In the event of a hardware problem, a
support ticket can provide vital information to help in diagnosing and
resolving the problem.

Accessing the Support Screen

To open the Support screen:

1. Click a device in the device list (By Product or By Connection
tab) to select it.

2. Click the Support button on the main toolbar to display the
Support screen.

Generating a Support Ticket

The Support screen presents three options for generating a support
ticket. Each of the following three options has a corresponding button in
the Generate Support Ticket section of the screen.

B View Support Ticket—Click this button to generate the support
ticket and immediately view it in the support ticket viewer. The
support ticket can later be saved or sent via e-mail. For more
information, see Viewing a Support Ticket.

B Save Support Ticket to File—Click this button to generate and
save the support ticket. The support ticket is saved as a log file with
the *./tt extension. The support ticket can later be viewed or sent via
e-mail. To view a saved support ticket, open it through Windows
Explorer, or use the Load command on the File menu.

B Send Support Ticket by E-mail—Click this button to generate the
support ticket and immediately send it via e-mail to an HP support
center (or other destination). Clicking this button opens a form that
allows you to provide all the necessary information. Complete the
form and click the Send button to send the e-mail. Using this option
does not save a copy of the support ticket locally, so you are advised
to click Save Support Ticket to File to save a copy for your own
reference. For more information, see Sending a Support Ticket by
E-mail.

Viewing a Support Ticket

After a support ticket is generated, it is displayed in the support ticket
viewer. This viewer is built into the L&TT program. Information is
displayed in a standard tree-view format. Click “+” and “~” to expand
and collapse sections of the support ticket. Use the standard navigation
keys (Home, End, Page Up, Page Down, and the arrow keys) and the
Windows scroll bars to navigate through the document.

Using the Tabular View

Items in the support ticket that are preceded with the Tabular View icon
( ) have additional information that can be displayed in Tabular
View. To view the additional information in Tabular View, click the icon.
One of the following occurs:

B Ifonly one view is available for the item you clicked, then a Tabular
View window immediately opens.

B If more than one view is available for the item you clicked, a
shortcut menu is displayed. Select the desired option and click OK.
The Tabular View window opens.

The Tabular View window supports the following operations:

B Sorting columns—Click a column header to sort by that column.
Repeatedly clicking the same column header toggles between
ascending and descending sort order.

B Filtering columns—Right-click a column header and choose
Filter from the context menu to filter a column. A dialog box
prompts you for the filter value. Enter a value and click Filter. To
remove the filter, right-click the column header again and choose
Clear Filter from the context menu.

B Exporting data—The Tabular View data can be exported as a CSV
(comma separated value) file. A CSV file is a text file in which
values are separated by a comma (or other specified separator).
Data in a CSV file can be imported by a variety of popular
spreadsheet and database applications such as Microsoft Excel and
Access. To export Tabular View data to a CSV file, choose Export
from the File menu. Enter the path and filename for the CSV file in
the dialog box and click Save.

Setting the Detail Level

The support ticket can display information in several different levels of
detail, depending on the setting displayed in the Current Detail Level
dropdown box. The following detail level settings are available:

B Highlights only

Normal

More detail

Everything (the highest level the end user can view)

Factory only (requires a factory password)

For more information about the information reported on a support ticket,
refer to the user guide or online help.

Sending a Support Ticket by E-mail

From the Support screen, click Send Support Ticket by E-mail to
generate the support ticket and immediately send it via e-mail to an HP
support center (or other destination). When you click Send Support
Ticket by E-mail, the E-mail Support Ticket dialog box is displayed.

Before L&TT can e-mail a support ticket, you must either have a MAPI-
compliant e-mail program (such as Microsoft Outlook or Outlook
Express), or you must set up an e-mail account using the Windows
Control Panel or Internet Explorer. For more information about setting
up an e-mail account, refer to the user guide or online help.

The E-mail Support Ticket dialog box is divided into three steps:

1. In Step 1, indicate whether this is a new support request or an
existing case.

W If this is a new support request, select the Send to support
provider to request support by e-mail option (this option is
the default). Enter the product number and product serial
number in the appropriate fields.

W If this is an ongoing support case, select the Send to support
provider in reference to an open case option and enter the
case reference number in the appropriate field.

2. In Step 2, enter the destination e-mail address. Use the dropdown
box to select from a list of HP support providers, or enter the e-mail
address manually.

3. In Step 3, specify the following additional information:

B Contact information—Enter your company name, contact
name, contact phone, and contact e-mail address.

B Attach Result Log—Select this option to attach the support
ticket to the e-mail for analysis by HP service personnel.

B Attach additional Event Log (only if requested)—Select
this option if you have been requested by HP service personnel
to send the event log. For more information about using the
event log, refer to the user guide or online help.

B Problem description—Enter a detailed description of the
problem you are having.

When you have completed the form, click Send.

Firmware Management

The Firmware Management functionality of L& TT provides a
convenient way to easily upgrade the firmware of connected devices.
Library firmware and firmware of drives within the libraries can be
upgraded as well. In many cases, multiple drives within the library can
be updated simultaneously to save time.

L&TT uses special firmware files that associate the firmware with a
particular product. This feature prevents the user from downloading the
wrong image and ensures that the downloaded firmware is the same or a
newer revision than the current device firmware.

Accessing the Firmware Management Screen

To access the Firmware Management screen, click the device you want
to update in the device list, then click the Firmware button on the main
toolbar.

Acquiring Firmware Files

L&TT firmware files are stored in the Firmware directory. This
directory is a subdirectory of the HP Library & Tape Tools
installation directory. Before upgrading any firmware, you must acquire
the firmware image file or files and copy them to the Firmware
directory. Firmware files can be obtained in three ways:

1. Select the device in the device listing and click the Firmware
button on the main toolbar. On the Firmware screen, click the
Local Files tab, and then click the Get Files from Web button at
the bottom of the tab. The downloaded files are automatically
placed in the Firmware directory.

2. From the L&TT menu bar, select Get Files From Web from the
File menu. The software links to the L&TT firmware ftp site and
lets you select firmware files to copy to your system. Downloaded
files are automatically placed in the Firmware directory. This
option is explained in detail in the following section.

3. Go to www.hp.com/support, choose the product family, then click
software updates and drivers. The latest firmware file is available
in L&TT format. For some products (such as standalone drives),
firmware is available as a single file. For other products (such as
tape libraries), the firmware is available in a self-extracting bundle
that includes library and drive firmware.

Note: Do not use the Get Firmware From Web functionality within L&TT
without an Infernet connection. Doing so can cause the system to lock up until it
has ti]((ned out in the operating system. This timeout value is operating system-
specific.

Note: If Check for Updates on Web is enabled in the tool preferences, L&TT
automatically informs the user when new firmware is available for any of the
connected storage products. L&TT performs this check each time it is started
(but not more than once per 24-hour period).

Using the Get Files from Web Functionality

The Windows version of L&TT offers comprehensive firmware
management functionality that finds and downloads firmware from the
HP website. This functionality obtains the most up-to-date information
about all available firmware files directly from the HP website. It then

compares this data set to the list of devices connected to the system and
the current firmware revisions present in those devices. Depending on
the selected filter options on the top of the screen, different subsets of
firmware files are presented. Firmware files that are needed to bring the
connected devices up to the latest firmware revisions are automatically
selected.

Note: L&TT scripts are also obtained using the Get Files from Web dialog box.
For more information on scripts, refer to the user guide or online help.

Accessing the Get Files from Web Dialog Box

You can access the Get Files from Web dialog box in two ways:
B Select Get Files from Web from the File menu
- or-
B Click the Get Firmware button on the Firmware Update screen

The Get Files from Web dialog box is displayed. Click the Firmware
(New Files Available) tab if it is not already selected.

Selecting and Downloading Updated Firmware Files

The Get Files from Web dialog box has four filter options:

B For devices on this system—These two options only show
firmware files matching devices that are currently connected to the
system.

— Show latest firmware only shows the most recent firmware
revision for each device.

—  Show all firmware shows all firmware revisions for each of
these firmware files.

B For all supported devices—These two options show firmware files
for all devices supported by LTT, even if not currently connected to
the system.

— Show latest firmware only shows the most recent firmware
revision for each device.

—  Show all firmware shows all firmware revisions for each of
these firmware files.

Select the appropriate option, and then verify that the correct firmware

files are selected. To download the selected files, click Download. The

files are automatically downloaded to the current firmware directory on
the local system. You can now use the firmware update functionality of
L&TT to upload the latest firmware to your devices.

Uploading Firmware to Devices

Before attempting to update any firmware files, you must first acquire
the latest firmware files and ensure that they are placed in the
Firmware directory. If you have not yet done this, see Acquiring
Firmware Files.

To upload firmware to a device:
1. Click the device you want to update in the device list.
2. Click the Firmware button on the main toolbar.

3. On the Update Firmware tab, click the checkbox next to the
device name to select it. If firmware is currently available for that
device, it is shown in the Firmware File dropdown box in the File
Selection section of the screen.

Note: You can select multiple devices and update them simultaneously.

4. Click the Start Update button at the bottom of the screen to begin
the update.

Caution: Make sure that no other programs attempt fo access the
device during the firmware update. Do not inferrupt the firmware
update. If the firmware update is interrupted, the device may not
operate and require physical repair.

L&TT creates a log of all firmware update activity. To view this log,
click the Firmware Update Results tab. Set the Current Detail Level
setting to the appropriate level. The default is Normal. The firmware log
is displayed in a standard tree-view format. If you want to clear the log,
click the Clear Log button.
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Tests

L&TT provides numerous tests for analyzing storage hardware. L&TT
tests are SCSI script-based. A SCSI script is a sequence of SCSI
commands sent to a device, usually for the purpose of testing the
device’s functionality. For more information about the types of tests
available, refer to the user guide or online help.

Running the Tests

To select and run a test manually:

1. Inthe device listing (either the By Product or By Connection tab),
click the device.

2. Click Test on the main toolbar. The Tests screen is displayed and
the Test Execution tab is selected by default.

3. Click the checkbox to the left of the device name that you want to
test. The Test Group dropdown box is enabled, listing all the tests
available for the selected device.

4. In the Test Group dropdown box, select the test that you want to
perform. A description of the selected test is displayed in the
Description text box.

5. If any options are available for the test you selected, the Options
button is enabled. Click the Options button to review and set the
desired options.

6.  Click the Start Test button to start the test.

Viewing Test Results

After the test has completed, click the Test Results tab to view the
results. The results of the test are displayed in the Test text box. A more
detailed Test Operation Log is displayed in the bottom section of the
screen. The information is presented as a report in a standard tree-view
format. Click “+” or “=” to expand or collapse a section of the report.
Select an option in the Current Detail Level dropdown box to display
more or less information in the Test Operation Log.
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This Getting Started Guide is intended as an overview of installation and
basic usage for HP StorageWorks Library and Tape Tools (L&TT). For
detailed information on any procedure, refer to the user guide or online
help.

The Microsoft Windows version of L&TT uses a graphical user interface
([EL0)), whereas the NetWare, HP-UX, Tru64, and Linux versions of the
program use a command screen interface ([CSI]). Click the appropriate
bookmark in the left panel to display the section of this guide that
corresponds to your operating environment.

Supported Products and Operating Systems

For a complete listing of compatible products, refer to the HP Library
and Tape Tools Compatibility Matrix found at:

http:/ / www.hp.com/ support/Itcompatibility

Finding Additional Information

The HP website provides the current version of L&TT for download, and
general information about the tool. Access the website at:

http://www.hp.com/support/tapetools

You can quickly access this website by clicking the L&TT Support link
in the navigation bar from any page in this Getting Started Guide.

Getting Support

E-mail support is available from |tf_team@hp.com. You should expect a
response within 24 hours (usually sooner) during a normal business
week.

Use this address to obtain support for L&TT, to report bugs, to provide
feedback on this manual, to report any issues with the L& TT website, or
to provide enhancement suggestions. HP appreciates feedback on how to
make improvements for future versions of L&TT.

Note: This address is intended to provide support for L&TT software. This
address is NOT for assistance in troubleshooting hardware products. Refer to
the éiocumentation that comes with your hardware for support options for that
product.

Installing L&TT for NetWare

To install the NetWare version of L&TT:
1.  Download the L&TT for NetWare file to a temporary directory.

2. From a client workstation, use any standard unzip utility* to extract
the file to the SYS: System)\ directory on the NetWare server.
Make sure that the option to create a directory is enabled in the
archiving software.

Note: * The unzip NLM that comes with later versions of NetWare has not
been tested and should not be used to unzip the archive.

Installing L&TT for HP-UX, Tru64, and
Linux
To install L&TT for HP-UX, Tru64, or Linux:

1. Log on as root.
2. Navigate to the temporary directory:
cd /tmp

3. Download or copy the L&TT tar file, hp_ltt<xx>.tar (Where <xx>
is the version number) to this directory. If you are copying the file
from a different location, enter the following (substitute the
directory in which the file currently resides for <directory name>):

cp /<directory name>/hp_ltt<xx>.tar /tmp

4.  Untar the L&TT tar file:
tar -xvf hp_ ltt<xx>.tar

5. Run the install script in the / tmp directory:
./install_hpltt<xx>

6.  After the software is successfully installed, enter the following
commands to remove the /tmp/1ltt directory and its contents:

cd /tmp
rm -rf 1tt
rm -rf install_hpltt

Starting L&TT

To start L&TT:
B For HP-UX, Tru64, and Linux:
Log on as root and execute the following commands:
cd /opt/ltt
./hp_1tt
B For Novell NetWare
From the server console, execute the following command:
hp_ltt\hp_1tt

‘When the CSI version of L&TT is started, an information screen is
displayed that offers basic information about navigating the screens.
Press any key to bypass this screen and start the device scan. L&TT
scans the system for connected devices. When the scan is complete, the
Main screen is displayed, as shown in Figure 1.

Type the co nding number to select a device. or enter a hlank command for
a command lis

Libraries/Autoloaders:

Processors/Enclos £

Drives:
1 HP HP35478A {Address: 0.3.8>

Other Devices:

Enter Command>
<{Enter a blank command for command list}—————————

Figure 1: CSI Main screen

Navigating the Screens

The top line of each screen displays the current screen name in
hierarchical format. Each “level” of screens is separated by the “>”
character. On each screen, some of the available commands take you to a
lower level in the hierarchy. To move back to the previous level, use the
up command. To exit L&TT, use the exit command.

On most of the screens, entering a blank command (pressing Enter
without typing any other text) displays a Command Help screen. This
screen contains a list of valid commands that can be executed on the
original screen from which you accessed the Command Help screen.
Figure 2 shows the Command Help screen accessed from the Main
screen.

Main > Command Help >

You are in the command help menu. Within this menu {onlyd e the numh
short cut for the corresponding command. Otherwise, type in the command.

Command Description

exit the tool

options ShowsSet the current options
about Show Program version information
device Selects the device by path

oad Load a support ticket
preferences Change the global preferences
review Review the scan details

select Selects the device by number

#
i
2
E)
4
5
6
?
8

Enter Command>_

Figure 2: Command Help screen accessed from the Main screen

It is possible to enter a command directly from the Command Help
screen. To do this, type either the number of the command or the name of
the command and press Enter. Entering the number of the command
only works on the Command Help screen. From any other screen, you
must type the full name of the command. To exit the Command Help
screen, enter a blank command (press Enter).

Some commands require an argument. For example, the select
command requires a number that corresponds to the device you want to
select in the device list. To select the first device in the list, the syntax is:

select 1

If you enter a command with an invalid or missing argument, an error
message is displayed.

Using the Device Information Screen

When you first select a product from the Main screen, the Device
Information screen opens, showing information relevant to the device.

The main purpose of the Device Information screen is to provide an
overview of the configuration and status of the selected hardware device.

From the Main screen, type the following command to access the
Device Information screen:

select <n> (where <n> is the number of the device you want to
examine)

Note: Alternatively, you can omit the select command and only enter the
device number.

Standalone Devices
Figure 3 shows the Device Information screen for a standalone device.
Main > Drive Information >

The following is identity information for the selected device. You can use
comnands to select functionality to perform on this device.

Product ID = HP35478A
Drive Technology : DDS—1
Mech. Serial Number D nfa
Firmware Rev = TeB3
Target ID 3

Target LUN : 8

OBDR Capability : Not Present

Cartridge Information (for cartridge currently in drived:
Cartridge Type : -1

* Capacity : 1.3-2GB-2.6—4GB

Write Protected : Mo

* Capacity varies by compre: n ratio and is system and data dependent.
Humhers represent capacity h no compression and with 2:1 compression

Figure 3: Device Information screen for a standalone device

The following general information is displayed:
Product ID (inquiry string)

Drive technology

Mech. serial # (drive serial number)
Firmware revision

SCSI target ID

SCSILUN


http://www.hp.com/support/lttcompatibility
http://www.hp.com/support/tapetools

B OBDR capability (if present)

If a data cartridge was inserted in the drive when the Device
Information screen was displayed, information regarding cartridge type,
capacity, and write-protect status is shown.

To see a list of compatible media that can be used with this device, use
the inventory command.

Library and Autoloader Products
Figure 4 shows the Device Information screen for a library.

Main > Identity >

The following is identity information for the selected device. You can use
commands to select functionality to perform on this device.

Product ID = 7208
Hodel Name ape Library 2,280

= Tap
# Internal Serial Number : DB1461MB279
Drive Technology : LTO
Firmuare Rev H =52B

LUN iB
i 2

» of Drives H
» of Slots 19

#* May not match external serial number

———<{Enter a hlank command for command list>——

Figure 4: Device Information screen showing a library

Note: Selecting individual drives within a library from the device list displays
the drive as though it were a standalone product. Embedded drives are best
diagnosed by selecting the library they belong to, and then selecting the
specific drive within each tool window.

From the Device Information screen for a library device, use the
inventory command to display the slot inventory of the library. The
inventory command shows which slots and drives currently have
cartridges loaded, and the cartridge barcode if available and applicable.

Support Ticket Generation

A major feature of HP StorageWorks Library and Tape Tools is the
ability to generate a support ticket. In the event of a hardware problem, a
support ticket can provide vital information to help in diagnosing and
resolving the problem.

Generating and Viewing a Support Ticket

To generate and view a support ticket in the CSI environment:

1. From the Main screen, select the device that you want to create a
support ticket for. The Device Information screen is displayed.

2. Enter the support command to access the Support screen.
3. From the Support screen, do one of the following:
B Enter the view command to view the support ticket.

B Enter the save <filename> command to save the support
ticket with the specified filename. The support ticket can be
viewed later using the 1oad command from the Main screen.

When viewing the support ticket, use Ctrl+U and Ctrl +D to scroll up
and down through the results. You can also use the £ind and page
commands to quickly locate information. For more information about
the information reported on a support ticket, refer to the user guide or
online help.

Firmware Management

The Firmware Management functionality of L&TT provides a
convenient way to easily upgrade the firmware of connected devices.
Library firmware and firmware of drives within the libraries can be
upgraded as well. In many cases, multiple drives within the library can
be updated simultaneously to save time.

L&TT uses special firmware files that associate the firmware with a
particular product. This feature prevents the user from downloading the
wrong image and ensures that the downloaded firmware is the same or a
newer revision than the current device firmware.

Acquiring Firmware Files

L&TT firmware files are stored in the £irmware directory, which is a
subdirectory of the HP Library & Tape Tools installation
directory. Before upgrading any firmware, you must acquire the
firmware image file or files and copy them to the firmware directory.

To download the latest firmware files:

1.  Go to www.hp.com/support, choose the product family, then click
software updates and drivers. The latest firmware file is available
in L&TT format. For some products (such as standalone drives),
firmware is available as a single file. For other products (such as
tape libraries), the firmware is available in a self-extracting bundle
that includes library and drive firmware.

2. Download the file or files to the £irmware directory.

3. If the downloaded files were self-extracting bundles, extract the
contents to the firmware directory.

Uploading Firmware to Devices

To upload firmware to one or more devices:

1. From the Main screen, type the number corresponding to the device
you want to update and press Enter to display the Device
Information screen.

2. From the Device Information screen, enter the firmware
command to display the Firmware Update screen. Devices that are
available for update are listed on this screen.

3. Type the corresponding number of the device that you want to
update and press Enter to mark the device “selected.” If there are
multiple devices, repeat this step for each device that you want to
update.

4. When you have selected all of the devices that you want to update,
enter the start command to begin the update process.

device while the firmware is being updated. Do not interrupt the
firmware update. If the firmware update is interrupted, the device
may not operate and require physical repair.

ij Caution: Make sure that no other programs attempt fo access the

L&TT creates a log of all firmware update activity. To view this log,
enter the review command from the Firmware Update screen.

Tests

HP L&TT provides numerous tests for analyzing storage hardware.
L&TT tests are SCSI script-based. A SCSI script is a sequence of SCSI
commands sent to a device, usually for the purpose of testing the
device’s functionality. For more information about the types of tests
available, refer to the user guide or online help.

Running the Tests (CSI Environment)

To select and run a test manually:

1. On the Main screen, enter the number corresponding to the device
that you want to test. The Device Information screen is displayed.

2. On the Device Information screen, enter the test command. The
Test screen is displayed. The Test screen displays the currently
selected test, and lists the available devices to be tested.

3. To select a different test, enter the picktest command. On the
Selector screen, enter the number of the test you want to perform.
The Test screen is redisplayed and the currently selected test is
updated.

4. To select or deselect devices to be tested, enter the corresponding
device number to toggle the selected status of the device. To
deselect all devices, enter the clear command.

5. Enter the start command to start the test.

When the test is complete a dialog is displayed showing
preliminary results of the test. Press any key to return to the Test
screen.

Viewing Test Results

To view detailed test results, enter the review command. Test results
are displayed in a hierarchichal format.

Use the detail command without any arguments to view the current
detail level of the report. Use the detail command with a numeric
argument to set the detail level. The available detail level arguments are
as follows:

B 1 — highlights only
2 — normal

3 — more details

4 — everything

5 — factory only (requires a factory password. To enter a password,
use the options command.)

If necessary, use Ctrl+U and Ctrl+D to scroll up and down through the
results. You can also use the £ind and page commands to quickly
locate information in the report.


http://www.hp.com/support
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